Network Interface Board
Type 450-E (Option)

Quick Configuration Guide

Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.



Introduction
To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the “Copy Reference” before using this machine. It contains im-
portant information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Trademarks

NetWare® is a registered trademark of Novell, Incorporated. Windows® is a registered trademark of Mi-
crosoft Corporation in the United States and/or other countries.

Macintosh® is a registered trademark of Apple Computer, Incorporated.

All other products referenced are trademarks or registered trademarks of their respective companies.
Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights in those marks.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Note

The name of the applications do not appear in the following pages. Confirm which applications you will
be using before reading this manual.

Descriptions in this manual Application

PRINTER MANAGER FOR ADMINIS- Aficio Manager for Admin
TRATOR

PRINTER MANAGER FOR CLIENT Aficio Manager for Client

Notes:

Some illustrations might be slightly different from your machine.
Certain options might not be available in some countries. For details, please contact your local dealer.



How to Read This Manual

Symbols

In this manual, the following symbols are used:

i@klmportant
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

4 Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

p Reference
This symbol indicates a reference.

[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.
[ ]

Keys built into the machine's operation panel.

Keys on the computer's keyboard.



Manuails for This Machine

There are seven manuals that separately describe the procedures for the instal-
lation of a machine and for the operation and maintenance of the machine and
its optional equipment.

To enhance safe and efficient operation of the machine, all users should read and
follow the instructions contained in the following manuals.

< System Settings
Describes the procedures and functions for adjusting the settings and defaults
of this machine for the copier.

< Copy Reference
Describes the procedures and functions for using this machine as a copier.

% Printer Reference 1
Describes the system settings, procedures and functions for using this ma-
chine as a printer.

% Printer Reference 2
Describes the procedures and provides necessary information about using

this machine as a printer. The manual is included as a PDF file on the CD-
ROM labeled “Printer Drivers and Utilities”.

< Network Interface Board Quick Configuration Guide

Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. The manual is in-
cluded as a PDF file on the CD-ROM labeled “Printer Drivers and Utilities”.
(This Manual)

Read this manual as your first choice before refering to the paper version of
the Quick Configuration Guide which comes with optional Network Inter-
face Board Type 450-E.

< PostScript 3 Operating Instructions Supplement
Describes the menus and features you can set using the PostScript printer
driver. The manual is included as a PDF file on the CD-ROM labeled “Printer
Drivers and Utilities”.

< Network Interface Board Type 450-E Owner's Manual
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. The manual is pro-
vided as a PDF file which is included on the CD-ROM labeled “Print Server
Software and Documentation” which comes with optional Network Interface
Board Type 450-E.
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1. Getting Ready for Software

Installation

Support programs for the installation and configuration of Network Interface
Board are included on two CD-ROMs. One is “Printer Drivers and Utilities”
which comes with this printer and the other is “Print Server Software and Doc-
umentation” which comes with optional Network Interface Board.

You can select any of the programs listed in the Configuration Programs.

Configuration Programs

The CD-ROM named "Printer Drivers and Utilities" includes the following utilities.

< PortNavi
IP Peer-to-Peer printing software
PortNavi is a utility that helps you to use network printers effectively. It is
useful in environments where two or more network printers are used. It is
recommended that you install PortNavi to use Parallel Printing and Recovery
Printing. For more information about PortNavi, see Help of PortNavi.

& Note

O Parallel Printing and Recovery Printing are not available when you print
without using the PCL6/5e printer driver.

* PortNavi Features
Allow you to send a print job directly to the network printers without us-
ing a print server.

¢ Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

i@klmportant
O The following settings must be the same for the specified printer and
the printers selected for Parallel Printing.

. Printers are the exact same model.

¢  Installed options (e.g. Paper Tray)

d Size and orientation of paper in each paper tray
e  Total memory

e  Installed fonts (including the downloaded fonts)

¢ Allow you to print documents using other printers in the printer group
when the specified printer is busy (Recovery Printing).

i@klmportant
O The following settings must be the same for the specified printer and
the printers selected for Recovery Printing.

. Printers are the exact same model.
. Installed options (e.g. Paper Tray)



Getting Ready for Software Installation

. Size and orientation of paper in each paper tray
e  Total memory

o Installed fonts (including the downloaded fonts)
< PRINTER MANAGER FOR ADMINISTRATOR

A utility for the system administrator to manage printers on the network.

p Reference
For the name of PRINTER MANAGER FOR ADMINISTRATOR, see in-
side the front cover of this manual.

See PRINTER MANAGER FOR ADMINISTRATOR Online Help for more
information about using PRINTER MANAGER FOR ADMINISTRATOR.

< PRINTER MANAGER FOR CLIENT

A utility for users to manage their own print status on the network.

p Reference
For the name of PRINTER MANAGER FOR CLIENT, see inside the front
cover of this manual.

See PRINTER MANAGER FOR CLIENT Online Help for more informa-
tion about using PRINTER MANAGER FOR CLIENT.

The CD-ROM named "Print Server Software and Documentation” includes the
following utilities.

< MAP
Web-based configuration utility

< IPX Peer-to-Peer

IPX Peer-to-Peer printing software

< IP Peer-to-Peer
IP Peer-to-Peer printing software

< BootP Lite

Used to configure the IP parameters of Network Interface Board

< NWSetup

NetWare Print Service Configuration

The five utilities are included on the “Print Server Software and Documenta-
tion” CD-ROM, but you need this CD-ROM only if you use "IPX Peer-to-Peer”
or “IP Peer-to-Peer” printing.

Although you can use the "MAP", "BootP Lite", or "NWSetup" utilities on the

"Print Server Software and Documentation" CD-ROM,, it is easier to use the NIB
Setup Tool included on the "Printer Drivers and Utilities" CD-ROM.

To use “MAP”, “BootP Lite”, or “NWSetup” from the “Print Server Software
and Documentation” CD-ROM, see the “Owner's Manual” (Type 450-E Manu-
al) on the CD-ROM labeled “Print Server Software and Documentation” for in-
structions.



Installing the NIB Setup Tool

Installing the NIB Setup Tool

A utility called NIB Setup Tool is provided to configure the printer to work in a
network environment. This section describes how to install PRINTER MANAG-
ER FOR ADMINISTRATOR, and how to run the NIB Setup Tool.

? Limitation

O The NIB Setup Tool is supported to work with the following operating sys-
tems.

e Microsoft Windows 95/98
e Microsoft Windows NT 4.0

Installing PRINTER MANAGER FOR ADMINISTRATOR

Follow these steps to install PRINTER MANAGER FOR ADMINISTRATOR.

E Preparation

You should install PRINTER MANAGER FOR ADMINISTRATOR on the
computer. If you install PRINTER MANAGER FOR ADMINISTRATOR from
a file server or run it via the network, PRINTER MANAGER FOR ADMINIS-
TRATOR might not work correctly.

Be sure to close all applications before starting the installation procedure.
ﬂ Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the setup menu starts automatically, follow the instructions on the screen.

If not, go to step B.
B Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ In the [Install/Uninstall] tab, click [Install].
B ciicic [Next >].

ﬂ In the [command line for installation program] box, type the name of the CD-
ROM drive followed by “PRINTMAN\ADMIN\SETUP.EXE” (do not in-
clude the quotation marks) and then click [Finish].

4 Note

O Anexample would be “D:\PRINTMAN\ADMIN\SETUP.EXE” when the
CD-ROM drive name is “D”.

ﬂ From the [Choose Setup Language] pop-up menu, select the language you
want to use.
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8 In the [Welcome] dialog box, click [Next >].

g The Software License Agreement appears.

After reading through all of the contents by clicking [PageDown], click [Yes] to
agree with the License Agreement.

[[D Select a folder to install PRINTER MANAGER FOR ADMINISTRATOR
in, and then click [Next >].

If you want to change the displayed folder, click [Browse] to select another
one.

The installation program starts.

When a confirmation dialog box appears, the installation program is com-
plete.

Running the NIB Setup Tool

I] Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [PRINT-
ER MANAGER FOR ADMINISTRATOR] program folder.

LfStatus page

The status page of Network Interface Board will be automatically printed in the
following cases:

* when the printer is turned on.

* when Network Interface Board is reset.

This feature can be disabled with NIB Setup Tool.

To disable this feature, check [Property Sheet] in the “NIB Setup Tool” screen,
click [Detailed...] in the [General] tab and remove the check from the box for [Print
configuration page on startup].



2. Windows 95/98
Configuration

Windows 95/98 Configuration

This section describes how to configure Peer-to-Peer printing. The Peer-to-peer
printing software that is included on the CD-ROM labeled “Printer Drivers and
Utilities” which contains PortNavi or “Print Server Software and Documenta-
tion” allows Windows 95/98 PCs to communicate directly with network at-
tached printers. A network server, such as NetWare or Windows NT, is not
required for Peer-to-peer printing.

There are three types of Peer-to-peer printing. You can select “PortNavi”, “IP
Peer-to-Peer” and “IPX Peer-to-Peer” according to your network environment.

The Peer-to-peer printing software must be installed on each PC that uses Peer-
to-peer printing. Once Peer-to-peer printing software is installed, all Network
Interface Boards on the network automatically appear in the list of available
printer ports.

The Peer-to-peer printing software can also be used in networks where servers
are present; however, server based print services are often utilized instead. Serv-
er based print services offer centralized printing management and spooling and
do not require software (other than the printer driver) to be installed on each PC.

If you use the printer in a network where servers are present, select either Peer-
to-peer printing or the server based print service.

/O Reference

For more information about setting IP parameters, see “Configuring the Printer
for the Network with the Operation Panel” in “Printer Reference 1”.
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Using PortNavi

ﬁklmportant

O To use PortNavi, you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of PRINTER MANAGER FOR CLI-
ENT you use, see the inside the front cover of this manual.

Installing PortNavi

Follow these instructions to install PortNavi.

ﬂ Configure the IP parameters on Network Interface Board using the opera-
tion panel.

/O Reference

For more information about setting IP parameters, see “Confiquring the
printer for the Network with the Operation Panel” in “Printer Reference 1”.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

4 Note

O If the installer starts automatically, use it to install PortNavi, and then go
to step @.

B Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ In the [Install/Uninstall] tab, click [Install].
B cicic [Next >].

B Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\PORTNAVI\DISK1I\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

& Note

O An example would be “D:\NETWORK\PORTNAVI\DISKI\SETUP.EXE”
when the drive letter is “D”.

ﬂ After the [Welcome] dialog box appears, click [Next >].

8 If PRINTER MANAGER FOR CLIENT is not installed, the [Question] dialog
box appears. When this occurs, click [No] and install PRINTER MANAGER
FOR CLIENT. If PRINTER MANAGER FOR CLIENT is installed, click
[Yes].

B click [ves].
The [Question] dialog box appears.



Using PortNavi

[ﬁ] If you want to read “Readme File”, click [Yes].

[I] After the [Setup Complete] dialog box appears, click [Yes, | want to restart my
computer now.], and click [Finish].

The computer restarts, and PortNavi can now be used. If you select “No”, be
sure to restart the computer manually before launching PortNavi for the first
time.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see Help of Port-
Navi.

ﬂ From the [Printers] window, click to select the icon of the printer which uses
PortNavi to print, and then click [Properties] in the [File] menu.

g Click the [Details] tab and confirm that the PortNavi port is shown in the
[Print to the following port] box.

Remember the port name because this port should be deleted later.
B From the drop-down menu in the [Print to the following port] box, select [FILE].
O click [Apply].

The port which is currently in use is changed.

B click [pelete Port].

B Click to select the PortNavi port name as confirmed in step B, then click
[OK].
The port is deleted.

ﬂ Click [OK] to close the printer properties.

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi with Windows 95/98.

iﬁklmportant

O If you want to switch the IP Peer-to-Peer port to the PortNavi port for print-
ing, delete or rename the IP Peer-to-Peer port before adding the PortNavi
port.

ﬂ Install the printer driver you want to use.
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g From the [Printers] window, click to select the installed printer icon, and
then click [Properties] in the [File] menu.

B Click the [Details] tab and click [Add Port].

ﬂ Click [Other], click to select [PortNavi] from the list and then click [OK].
The [Select Printer] dialog box appears.
The displayed items are as follows:
Model Name: The Model Name of the printer.
Name: The name of Network Interface Board.
Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.

B Click to select the model name of the printer, and then click [OK].

If you want to select a printer which is not shown here, click [IP Address] to
type the IP address.

B Confirm that the PortNavi port name is shown in the [Print to the following
port] box, and click [OK].
The PortNavi port name is shown as "IP address@model name".
The configuration is now complete.

When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.

Accessing the Port Settings Dialog Box

This section describes accessing the Port Settings dialog box to enable Parallel
Printing and Recovery Printing.

p Reference

For more information about the procedures for Parallel Printing and Recov-
ery Printing, see Help of PortNavi.

ﬂ Click [Start] on the taskbar, point to [Settings], and click [Printers].

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

E] sclect the [Details] tab and click [Port Settings].
The PortNavi settings dialog box appears.
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Using IP Peer-to-Peer

ﬁklmportant

O The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that
the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

ﬁklmportant
O Confirm that the printer power is turned on before starting the following pro-
cedure.

O If you want to switch the PortNavi port to the IP Peer-to-Peerport for print-
ing, delete or rename the PortNavi port before adding the IP Peer-to-Peer-
port.

ﬂ Configure the IP parameters on Network Interface Board using the opera-
tion panel.

/O Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”.

ﬂ Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

& Note

O If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
3.0].

E] click [cD ROM Contents].
The “Introduction” page appears.

ﬂ Click [Installation/Configuration Programs].
The “Configuration Programs” page appears.

B Click [Windows 95/98 & NT 4.x IP Peer-to-Peer Printing].
The “Windows 95/98 and NT 4.x IP Peer-to-Peer Printing” page appears.
This page describes the functions of this utility.

B At the bottom of the page, click the blue word [here] to begin installing.
A dialog box appears asking if the “Setup.exe” program should be started.
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U crici ves).
The [Welcome] dialog box appears.

B cick [Nexi].
The [Installation Notes] dialog box appears.

B click [ves].
The [Choose Destination Directory] dialog box appears.

[ﬁ] Click [Browse] to set a different folder.
The default installation folder is C:\PROGRAM FILES\IP-P2P.

0 cick [Nexi].
The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

[B Type the name that you wish to see in “Program Folder:” and click [Next].
The files are then copied to the computer in the specified directories.
The [Information] dialog box appears.

[B Click [OK] to complete the installation.

p Reference

For more information about installing IP Peer-to-Peer, see the “Owner's
Manual” (Type 450-E Manual) on the CD-ROM labeled “Print Server Soft-
ware and Documentation”.

3£For manual installation

Follow these steps to install the software on your operating system (Windows
95/98).

@ Insert the CD-ROM into the CD-ROM drive.
@ Close all the applications that are currently running.
® Click [Start] on the task bar, and click [Run].

@ Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

® Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to @- i in the preceding procedure. = P.7 “Set-
ting Up the Printer Driver”



Using IP Peer-to-Peer

Selecting the Printer Port

The Peer-to-peer printing software should be installed on each Windows 95/98
PC that will use Peer-to-peer printing services.

ﬂ Install the printer driver you want to use.
If the printer drivers have already been installed, you can go to the next step.

A Reference
For more information about the printer drivers, see “Installing the PCL 6/5e

Printer Driver” or “Installing the PostScript Printer Driver” in “Printer Refer-
ence 1”.
ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to set for Peer-to-peer printing.

ﬂ On the [File] menu, click [Properties].
The Printer Properties appear.

B click the [Details] tab.

E From the [Print to the following port:] list box, select the port of the printer you
want to use for Peer-to-peer printing.

* Select the IP address of the printer. If you do not find the IP address of the
printer, the printer is not in your local subnet. Then you need to configure
IP Peer-to-Peer port manually as described in the “Owner's Manual” (Type
450-E Manual) on the CD-ROM labeled “Print Server Software and Docu-
mentation”.

U click [ok].

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about IP Peer-to-Peer, see the
“Owner's manual” (Type 450-E Manual).

ﬂ Click [Start] on the taskbar, point to [Programs], and then click [IP-P2P].
The [IP-Peer to Peer Setup] window appears.

g Click [Printers...].

E) Click [Find Printers].
Available printers appear.

11
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ﬂ Click to select the port you want to delete from “Unit Name” list.
H ciick [pelete].



Using IPX Peer-to-Peer

Using IPX Peer-to-Peer

ﬁklmportant

O The IPX protocol is required for IPX Peer-to-Peer printing. Confirm that the
IPX protocol is installed, if not, install it before starting the following proce-
dure.

Installing IPX Peer-to-Peer

Follow these steps to install IPX Peer-to-Peer.

ﬂ Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

& Note

O If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
3.0].

B ctick [cD ROM Contents].
The “Introduction” page appears.

B Click [Installation/Configuration Programs].
The “Configuration Programs” page appears.

ﬂ Click [Windows 95/98 & NT 4.x IPX Peer-to-Peer Printing].
The “Windows 95/98 and NT 4.x IPX Peer-to-Peer Printing” page appears.
This page describes the functions of this utility.

B At the bottom of the page, click the blue word [here] to begin installing.
A dialog box appears asking if the “Setup.exe” program should be started.

(3 click [ves).
The [Welcome] dialog box appears.

U ciick [Nexi].
The [Installation Notes] dialog box appears.

B click ves).
The files are then copied to the computer in the specified directories.
The [Installation Complete] dialog box appears.

g Click [Finish] to complete the installation.

13
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’Q‘For manual installation

Follow these steps to install the software on your operating system (Windows
95/98).

@ Insert the CD-ROM into the CD-ROM drive.
@ Close all the applications that are currently running.
® Click [Start] on the taskbar, and click [Run].

@ Type <Drive>:\IPX-P2P\SETUP.EXE (where <Drive> is your CD-ROM
drive name).

® Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to @ -Bin the preceding procedure. = P.13 “In-
stalling IPX Peer-to-Peer”

Selecting the Printer Port

The Peer-to-peer printing software should be installed on each Windows 95/98
PC that will use Peer-to-peer printing services.

ﬂ Install the printer driver you want to use.
If the printer drivers have already been installed, you can go to the next step.

iﬁklmportant
O Using IPX Peer-to-Peer printing, confirm that the printer power is turned

on before continuing the following steps.

p Reference

For more information about the printer drivers, see “Installing the PCL 6/5¢
Printer Driver” or “Installing the PostScript Printer Driver” in “Printer Refer-
ence 1”.

g Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to set for the Peer-to-peer printing.

ﬂ On the [File] menu, click [Properties].
The Printer Properties appear.

B Click the [Details] tab.



Using IPX Peer-to-Peer

E From the [Print to the following port:] list box, select the port of the printer you
want to use for Peer-to-peer printing.

* Select the printer name. The printer name is shown in "Peer-to-Peer Con-
nection Information" on the network configuration page. The default set-
ting of the printer name is “RDP_" followed by the six digit serial number.

U crick [ox;.

15
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3. Windows NT 4.0
Configuration

Windows NT 4.0 Configuration

There are several options for setting up printing in a Windows NT environment.

o If a NetWare server is present, NetWare print services might be used by fol-
lowing the NetWare Configuration instructions in this guide.

* Peer-to-peer print services can be available by using “PortNavi” or “IP Peer-
to-Peer”.

* LPR print services can be used via TCP/IP by following the instructions in
this section.

Windows NT printing is very flexible. It is possible to configure the individual
Windows NT or Windows 95/98 workstations to print using a different protocol
from the Windows NT server. For example, a Windows NT server could be con-
figured to print to Network Interface Board via TCP/IP using the instructions in
this section. Network Interface Board could then be designated as shared on the
NT server, allowing workstations to print via the NT server using a different
protocol (such as NetBEUI).

The optimum Windows NT printing configuration depends on the particular
environment and user as well as administrator experience and preferences. Gen-
erally, LPR printing over TCP/IP covered in the following instructions is the
best choice for environments where TCP/IP is already in use.

17
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Using PortNavi

ﬁklmportant

O To use PortNavi, you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of PRINTER MANAGER FOR CLI-
ENT you use, see the inside of the front cover of this manual.

Installing PortNavi

Follow these instructions to install PortNavi.

ﬂ Configure the IP parameters on Network Interface Board using the opera-
tion panel.

/O Reference

For more information about setting IP parameters, see “Confiquring the
printer for the Network with the Operation Panel” in “Printer Reference 1”.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

4 Note

O If the installer starts automatically, use it to install PortNavi, and then go
to step @.

B Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ In the [Install/Uninstall] tab, click [Install].
B cicic [Next >].

B Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\PORTNAVI\DISK1I\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

& Note

O An example would be “D:\NETWORK\PORTNAVI\DISKI\SETUP.EXE”
when the drive letter is “D”.

ﬂ After the [Welcome] dialog box appears, click [Next >].

8 If PRINTER MANAGER FOR CLIENT is not installed, the [Question] dialog
box appears. When this occurs, click [No] and install PRINTER MANAGER
FOR CLIENT. If PRINTER MANAGER FOR CLIENT is installed, click
[Yes].

B click [ves].
The [Question] dialog box appears.
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[ﬁ] If you want to read “Readme File”, click [Yes].

[I] After the [Setup Complete] dialog box appears, click [Yes, | want to restart my
computer now.], and click [Finish].

The computer restarts, and PortNavi can now be used. If you select “No”, be
sure to restart the computer manually before launching PortNavi for the first
time.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see Help of Port-
Navi.

ﬂ From the [Printers] window, click to select the icon of the printer which uses
the PortNavi port to print, then click [Properties] in the [File] menu.

g Click to select the [Ports] tab, then confirm that the PortNavi port is shown
in the [Print to the following port(s)] box and that the check box is selected.

Remember the port name because this port should be deleted later.
B Click to select the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same printer.
(3 Click to select the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the PortNavi port name as confirmed in step B.

Do not select the check box.
B click [pelete Port].

g When the confirmation message appears, click [Yes].
The port is deleted.

[[D Click [OK] to close the Printer Properties.
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi with Windows NT 4.0.

iﬁklmportant

O If you want to switch the IP Peer-to-Peer port to the PortNaviport for print-
ing, delete or rename the IP Peer-to-Peer port before adding the PortNavi
port.

ﬂ Install the printer driver you want to use.

g From the [Printers] window, click to select the installed printer icon then
click [Properties] in the [File] menu.

B Click to select the [Ports] tab and then click [Add Port].

ﬂ Click to select [PortNavi] in the [Available Printer Ports] box, and then click [New
Port].

The [Select Printer] dialog box appears and printers on the network are
browsed.

The displayed items are as follows:

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.

B Click to select the model name of the printer, and then click [OK].

If you want to select a printer which is not shown here, click [IP Address] to
type the IP address.

E Click [Close] in the [Printer Ports] dialog box.

ﬂ Confirm that the name of the PortNavi port is shown in the [Print to the fol-
lowing port(s)] dialog box and its check box is selected, and then click [OK].
The name of the PortNavi port is shown as "IP address@model name".

The configuration is now complete.

When printing, select the configured printer and print as usual. Printing will
be done automatically by PortNavi.
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Accessing the Port Settings Dialog Box

This section describes accessing the Port Settings dialog box to enable Parallel
Printing and Recovery Printing.

A Reference
For more information about the procedures for Parallel Printing and Recov-
ery Printing, see Help of PortNavi.

ﬂ Click [Start] on the taskbar, point to [Settings], and click [Printers].

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

E] select the [Ports] tab and click [Configure Port].
The PortNavi settings dialog box appears.

2]
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Using IP Peer-to-Peer

ﬁklmportant

O The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that
the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

ﬁklmportant
O Confirm that the printer power is turned on before starting the following pro-
cedure.

ﬂ Configure the IP parameters on Network Interface Board using the opera-
tion panel.

/O Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”.

ﬂ Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

& Note

O If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
3.0].

E] click [cD ROM Contents].
The “Introduction” page appears.

ﬂ Click [Installation/Configuration Programs].
The “Configuration Programs” page appears.

B Click [Windows 95/98 & NT 4.x IP Peer-to-Peer Printing].
The “Windows 95/98 and NT 4.x IP Peer-to-Peer Printing” page appears.
This screen describes the functions of this utility.

B At the bottom of the page, click the blue word [here] to begin installing.
A dialog box appears asking if the “Setup.exe” program should be started.

U crici ves).
The [Welcome] dialog box appears.
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B crici pNext).
The [Installation Notes] dialog box appears.

B click [ves].
The [Choose Destination Directory] dialog box appears.

[[D Click [Browse] to set a different folder.
The default installation folder is C:\PROGRAM FILES\IP-P2P.

0 crick [Nexi].
The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

[B Type the name that you want to see in the Program Folder and click [Next].
The files are then copied to the computer in the specified directories.
The [Information] dialog box appears.

[B Click [OK] to complete the installation.

’Q‘For manual installation

Follow these steps to install the software on your operating system (Windows
NT 4.0).

@ Insert the CD-ROM into the CD-ROM drive.
® Close all the applications that are currently running.
® Click [Start] on the taskbar, and click [Run].

@ Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

® Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to B- @ in the preceding procedure. = P.22 “In-
stalling IP Peer-to-Peer”

23
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Selecting the Printer Port

The IP Peer-to-Peer printing software should be installed on each Windows NT
4.0 PC that uses Peer-to-peer printing services.

iﬁklmportant
O The IP Peer-to-Peer printing software must be installed before selecting the
printer port.

O If you want to switch the PortNavi port to the IP Peer-to-Peerport for print-
ing, delete or rename the PortNavi port before adding the IP Peer-to-Peer-
port.

ﬂ Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
“Installing the PCL 6/5e Printer Driver” in “Printer Reference 1” to start the in-
stallation and then go to the next step.

B The [Printer Installation] dialog box appears.

ﬂ From the [Port] list, select the IP address of the printer you want to set up,
and click [Next >].

B Follow the instructions on the screen to finish the installation of the printer
driver.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about IP Peer-to-Peer, see the
“Owner's manual” (Type 450-E Manual).

ﬂ Click [Start] on the taskbar, point to [Programs], and then click [IP-P2P].
The [IP-Peer to Peer Setup] window appears.

g Click [Printers...].

E) clici [Find Printers].
Available printers appear.

ﬂ Click to select the port you want to delete from “Unit Name” list.
B click [pelete].
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Setting Up LPR Printing

Follow these steps to set up LPR printing.

& Note

O In the following instructions, some fields or dialog box names may differ de-
pending on the NT service pack in use.

ﬂ Configure the IP parameters on Network Interface Board using the opera-
tion panel.

p Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Control Panel].

B Double-click [Network] and select the [Protocols] tab to confirm that the TCP/
IP protocol is installed.

If the TCP/IP protocol is not in the list of Network Protocols, click [Add] to in-
stall it.

O select the [Services] tab.

If Microsoft TCP/IP Printing is not on the list of Network Services, click [Add]
to install it.

B Click [Close] when all protocols and services have been added.

If the TCP/IP protocol has just been added, set the IP address and other TCP/
IP parameters.

The new protocols and services will be available after the system is restarted.

iﬁklmportant
O If the printer driver has not been installed yet, install it before continuing.

E Click [Start] on the taskbar, point to [Settings], and then click [Printers].
ﬂ Right click the appropriate printer and select [Properties].

B on the [Ports] tab, click [Add Port].

g Double-click [LPR Port] in the list of available printer ports.

[E] In the [Name or address of server providing Ipd:] field, type the IP address of
Network Interface Board (that was assigned with the operation panel).

[i] In the [Name of printer or print queue on that server:] field, type “PORT1” (quo-
tation marks are not included) in capital letters and click [OK].

25
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m Click [Close] to close the [Printer Ports] dialog box.

The IP address of Network Interface Board is now displayed and currently se-
lected on the list of ports.

[B If the printer is to be shared, click the [Sharing] tab, select Shared and type
the Share name.

@ cick [oK].



e
4. Dynamic Host Configuration

Protocol(DHCP)

Dynamic Host Configuration Protocol
(DHCP)

The Dynamic Host Configuration Protocol (DHCP) provides a mechanism for
delivering IP configuration parameters, including the IP address, subnet mask
and default gateway, to devices (hosts) on an IP network. A DHCP server man-
ages the pool of available IP addresses and grants device requests for an IP ad-
dress.

At power-up, Network Interface Board broadcasts a DHCP request for an IP ad-
dress. If a DHCP server is present, the request is processed, and an IP address is
returned to Network Interface Board. Upon receipt of the IP address, Network
Interface Board resets, and prints a network configuration page. The network
configuration page lists the new IP address (and Subnet mask and default gate-
way). Once an IP address has been assigned to Network Interface Board, it no
longer broadcasts DHCP requests.

i@klmportant
O The IP address of Network Interface Board assignment by DHCP works only
if Network Interface Board does not have an existing IP address.

The DHCP server leases a temporary IP address which expires after a period of
time, or leases a permanent or unlimited lease which does not expire.

Devices that are granted a temporary lease are notified before the lease expires
and asked if they want to extend the lease. Network Interface Board continues
extending its lease indefinitely (unless prohibited by your DHCP server config-
uration) and thus maintains a consistent IP address.

i@klmportant

O If Network Interface Board is not turned on or is not connected to the network
during the period when the DHCP server is sending requests to extend the
lease, the lease will not be extended. The DHCP server cancels the lease and
assigns the IP address to another device. Therefore, it is highly recommended
that you reserve an IP address for Network Interface Board in your DHCP
server configuration.

If you do not to use DHCP for IP address assignment, it can be disabled using
the NIB Setup Tool. The NIB Setup Tool allows you to use a Wizard or a Prop-
erty Sheet to configure Network Interface Board. Use the Property Sheet to dis-
able this feature. After you select Network Interface Board with the NIB Setup
Tool, click [Configure] and then click the [TCP/IP] tab. If you do not use DHCP, se-
lect [Specify an IP Address] and set the IP address, the subnet mask and the default
gateway address.

27
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e
5. NetWare Configuration

Quick Setup Using the NIB Setup Tool
Wizard

Using the NIB Setup Tool, you can easily set up a NetWare printing environment.

/O Reference

For more information about setting up the NIB Setup Tool, see P.3 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.

When you configure Network Interface Board for the first time, use the Wizard
method.

If you want to use the Property Sheet method, see P.32 “NetWare 3.x - Advanced
Settings” and P.35 “NetWare 4.x, 5 - Advanced Settings”.

4 Note

O This section assumes that NetWare is functional and that the necessary envi-
ronment for NetWare Print Services is available.

O If you configure Network Interface Board in a NetWare environment using
the NIB Setup Tool, you should install the client software released from No-
vell in the following cases.

¢ Windows 95/98 in NDS mode configuration
e Windows NT 4.0 in NDS mode configuration
¢ Windows NT 4.0 in Bindery mode configuration

ﬂ Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

B Run the NIB Setup Tool.

A Reference
= P.4 “Running the NIB Setup Tool”

B Click [Wizard] and click [OK].
The [Network board list] dialog box of Network Interface Board appears.

ﬂ Click [IPX protocol].

ﬂ Click to select the IPX address of Network Interface Board you are config-
uring, and click [Next >].

4 Note

O If you do not know which Network Interface Board you are configuring,

print a network configuration page to confirm the MAC address (Network

address). 50
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E Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].
ﬂ Type the print server name into the [Device Name] box, and click [Next >].

The default setting is “RDP_" followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of your network.

B In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

B cricic [Next 5.

A dialog box for configuring the NetWare environment appears.

[[D Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

ﬂ] If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

[B If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among those
listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

B clicic [Next >].

ﬂ] Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1"
and that for Print Queue Name is “Print Server Name” followed by “_Q”
(quotation marks are not included). You can change them if necessary.
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iE If you have selected NDS mode, type the volume of the print queue into the
[Queue Volume] box.

Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

0@ crici [Next »].
A dialog box to confirm the printing environment appears.

[ﬂ After confirming the environment, click [Next >].
If you want to change the settings, click [< Back] and make the settings again.
Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

[B After a confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 3.x environment.

( 1)
Basic Procedure

[Installing the NIB Setup Tool]

[Configuring Network Interface Board ]

[Configuring NetWare ]

[ Turning the power off and on ]

- J

5] Preparation
The following procedures use the Property Sheet method in configuring Net-
work Interface Board. If you configure Network Interface Board as a NetWare
print server for the first time, we recommend you use the Wizard method. For
more information, see P.29 “Quick Setup Using the NIB Setup Tool Wizard”.

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

Setting Up as a Print Server

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
= P.4 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].
The [Browse] dialog box of Network Interface Board appears.

O click ppx protocol].

B Click to select the IPX address of Network Interface Board which is to be
configured, and then click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see the network configuration page to confirm the MAC address (Network
Address).
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E Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

 ciick [Contigure].
The property sheet appears.

8 Click the [General] tab, and type the name of the print server into the [Device
Name] box.

B) Click the [NetWare] tab, and make the following settings.

@ Select [Bindery].

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

© Click [OK] to close the property sheet.
O After a confirmation dialog box appears, click [OK].

[ﬁ] On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

ﬂ] Type “PCONSOLE” from the command prompt.
F:> PCONSOLE

[B Create a print queue as follows.

& Note
O If you use a currently defined print queue, go to step B.

@ From the [Available Options] menu, select [Print Queue Information] and press
the [ ENTER] key.

@ Press the [INSERT] key and type a print queue name.
© Press the [ESC] key to return to the [Available Options] menu.

[B Create a printer as follows.

@ From the [Available Options] menu, select [Print Server Information] and press
the [ENTER] key.

@ To create a new print server, press the [INSERT]) key and type a print
server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

iﬁklmportant
O3 Use the same name as that specified in the NIB Setup Tool. (Step B).

@ From the [Print Server Information] menu, select [Print Server Configuration].
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O From the [Print Server Configuration menu], select [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.
O If you change the name of the printer, type a new name.

A name "Printer x" is assigned to the printer. “x” stands for the number of
the selected printer.

@ As Type, select [Remote Other/Unkown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

@ Press the [ESC] key, and click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to the [Print Server Configuration] menu.

ﬂ] Assign print queues to the created printer as follows.
@ From the [Print Server Configuration] menu, select [Queues Serviced By Printer].
@ Select the printer created in step B.
@ Press the [INSERT] key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

O Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, confirm that the queues are as-
signed.

iE Press the [ESC] key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

[E Turn the printer power off and on.

& Note

O To confirm that the printer is configured correctly, type as follows from the
command prompt.

F:> USERLIST

O If the printer works as configured, the name of the print server appears as
an attached user.
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NetWare 4.x, 5 - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 4.x and 5 environment.
% To use NetWare 5

¢ Load the IPX protocol into the file server in advance.

* You cannot use Pure IP and NDPS (Novell Distributed Print Services)
mode.

Basic Procedure

(Installing the NIB Setup Tool |

[Configuring Network Interface Board ]

[Configuring NetWare ]

[ Turning the power off and on ]

- J

5] Preparation
The following procedures use the Property Sheet method in configuring Net-
work Interface Board. If you configure Network Interface Board as a NetWare
print server for the first time, we recommend you use the Wizard method. For
more information, see P.29 “NetWare Configuration”.

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

O You should install the client software released from Novell on Windows be-
fore running the NIB Setup Tool for configuring in NDS mode or using Win-
dows NT 4.0.

Setting Up as a Print Server

ﬂlmportant

O You can set up the print server using NDS or Bindery mode in NetWare 4.x,
5. The following procedure is for setting up the print server using NDS mode
in NetWare 4.1. When you set up the print server using Bindery mode, use
the NIB Setup Tool Wizard. = P.29 “Quick Setup Using the NIB Setup Tool Wiz-
ard”
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ﬂ Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
= P.4 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].
The [Browse] dialog box of Network Interface Board appears.

O click ppx protocol].

B Click to select the IPX address of Network Interface Board which is to be
configured, and click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see the network configuration page to confirm the MAC address (Network
Address).

B Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and type the name of the print server into the [Device
Name] box.

g Click the [NetWare] tab, and make the following settings.
@ Select [NDS].

@ Type into the [Tree:] box the name of the NDS tree in which the print
server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".
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© Click [OK] to close the property sheet.
O After a confirmation dialog box appears, click [OK].

[[D On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
ﬂ] From Windows, run NWAdmin.

/O Reference

For more information about NW Admin, see the documentation that comes
with NetWare.

[ﬂ Create a print queue as follows.

@ Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

@ In the [Class of new object] box, click to select “Print Queue”, and click
[OK].

© In the [Print Queue name] box, type the name of the print queue.
O In the [Print Queue Volume] box, click the [Browse] button.

@ In the [Available objects] box, click to select the volume in which the print
queue is created, and click [OK].

O After confirming the settings, click [Create].

[B Create a printer as follows.

@ Select the container object the printer is located in, and click [Create] on
the [Object] menu.

@ In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5, click “Printer (Non NDPS)”.

© In the [Printer name] box, type the name of the printer.
O Click to select [Define additional properties] to check a box, and click [Create].

ﬂ] Assign print queues to the created printer as follows.
@ Click [Assignments], and click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step B, and click
[OK].

© Click [Configuration], and in the [Printer type] box, select [Parallel] using the
dropdown menu, and then click [Communication].

O Click [Manual load] in the [Communication type] group, and click [OK].
@ After confirming the settings, click [OK].

iE Create a print server as follows.

@ Select the context specified using the NIB Setup Tool (step B-A), and on
the [Object] menu, click [Create].

@ In the [Class of new object] box, click “Print Server”, and click [OK].
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© In the [Print Server name] box, type the name of the print server.

ﬂlmportant
O Use the same name as that specified using the NIB Setup Tool. (Step B)

O Click to select [Define additional properties] check box, and click [Create].

[E Assign the printer to the created print server as follows.
@ Click [Assignments], and click [Add] in the [Assignments] group.

@ In the [Available objects] box, click to select the printer created in step (B,
and click [OK].

© After confirming the settings, click [OK].
[ﬂ Turn the printer power off and on.

& Note

O If the printer works as configured, the name of the print server appears as
an attached user.
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

& Note

O This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setup procedure.

Windows 95/98

Follow these steps to set up a Windows 95/98 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Install the printer driver you want to use as “Local printer”.

p Reference

For more information about installing the printer driver, see“Installing the
PCL 6/5e Printer Driver” in “Printer Reference 1” and “Installing the Post-
Script Printer Driver” in “Printer Reference 1”.

& Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Clicic [Start], point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the printer you want to use.
O 0n the [File] meny, click [Properties].

B click the [Details] tab, and click [Add Port].

(3 ciici [Network] and click [Browse].

ﬂ On the network tree, double-click the name of the file server.
The queues appear.

8 Click the queue you want to print, and click [OK].

B ciick ok;.
In the [Print to the following port] box, a network path to the printer appears.

[ﬁ] Click [OK] to close the Printer Properties, and again, open it.
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NetWare Configuration

[ Click the [Printer Settings] tab.
[ﬂ Clear the [Form feed] and [Enable banner] check boxes.

& Note

O You should not select these check boxes because they should be specified
using the printer driver. If they are selected, the printer might not print
correctly.

When Using the PostScript Printer Driver

Follow these steps to set up for the PostScript Printer Driver

@ Click the [PostScript] tab.

@ Click [Advanced].

@ Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

[B Click [OK] to close the Printer Properties.

Windows NT 4.0

Follow these steps to set up a Windows NT 4.0 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.
B crici [NoJ.
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
“Installing the PCL 6/5e Printer Driver” and “Installing the PostScript Printer
Driver” in “Printer Reference 1” to start the installation and then go to the next
step.

B The [Printer Installation] dialog box appears.
E From the [Port] list, select the queue you selected in step @, and click [Next >].

ﬂ Follow the instructions on the screen to finish the installation of the printer
driver.



e
6. Macintosh Configuration

Configuring a Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may differ depending on the
version of the Mac OS. If you are not using Mac OS 8, see the manual that comes
with your version of the Mac OS for more information.

Changing to EtherTalk

/O Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

B Open [Control Panels], and double-click the [AppleTalk] icon.

ﬂ Select [Ethernet] from the [Connect via:] pop-up menu.

B If you change zones, select a name from the [Current zone:] pop-up menu.
ﬂ Close the [AppleTalk] control panels.

ﬂ Restart the Macintosh.

Changing the Printer Name

If the network has several same model printers, the names will be the same.
Printers that have the same name will have their names changed slightly in the
Chooser. For example, three printers named “printer” will appear in the Choos-
er as “printer0”, “printerl” and “printer2”.

Use applications such as Apple Printer Utility or LaserWriter Utility to change
printer names in the Macintosh EtherTalk environment. These utilities are dis-
tributed by Apple Computer, Inc.
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/. UNIX Configuration

UNIX Configuration

UNIX printing utilizes a line printer daemon (Ipd) to direct jobs to the printer.
With printer-based Ipd, Network Interface Board acts as the line printer daemon
host and accepts print jobs directly.

TCP/IP configuration of Network Interface Board is needed for all versions of
UNIX. See the “Owner's Manual” (Type 450-E Manual) for lpd configuration.

4 Note

O Be sure to turn the printer off and on after changing the network configura-
tion.

/O Reference

For information about setting IP parameters, see “Configuring the Printer for
the Network” in “Printer Reference 1” that comes with the printer.

Setting the IP Address

The IP address of Network Interface Board may initially be set in a variety of
ways; including with the MAP utility when a NetWare server is present, with
the UNIX bootp daemon, with rarp, or with the standard UNIX command line
utility, arp.

The following instructions use arp, but the other methods may be used instead,
depending on user preference.

For more information about using one of the other methods, see the “Owner's
Manual” (Type 450-E Manual).

ﬂ Turn the printer off and then on and wait for the power-up network status
page to print.

ﬂ Add an entry to the hosts file (usually etc/hosts) that includes the printer's
name and the IP address.

For example, to name the printer and associate it with an IP address of
197.42.211.5, place the following entry in the hosts file:197.42.211.5 <Printer-
Name>

BAt the UNIX command prompt, type: arp -s <desired_IP_address>
<NIB_Ethernet_address>

(The Ethernet address is listed on the network status page as Network Ad-
dress.)

For example, arp -s 197.42.211.5 00:40:AF:13:A2:70
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UNIX Configuration

ﬂ At the UNIX command prompt, type: ping <desired_IP_address>

For example, ping 197.42.211.5. Network Interface Board will not respond to
this ping command, but will read the IP address.

B After a few minutes (usually between one and two minutes, but possibly
up to five minutes on very large or busy networks), Network Interface
Board will reset and print its network status page.

The new IP address will be listed in the TCP /IP Network Information section.

If the status page is not printed, recheck the Ethernet address of Network In-
terface Board entry in the arp command.

Once the status page is printed, the new IP address may also be verified with
the ping command.

Setting Other TCP/IP Parameters

Once the IP address is set, Network Interface Board can be configured via telnet
or with a standard web browser.

The following steps describe configuration with a standard browser.

For more information about configuring via telnet, see the “Owner's Manual”
(Type 450-E Manual).

ﬂ In the browser, connect to http://<NIB_IP_address>
For example, http://197.42.211.5

ﬂ At Home Page of Network Interface Board, click Network Configuration.

B Many of the configuration options are password protected.
The default password is: sysadm
The password is case sensitive.
To change the password, select Change Password in the System column.

ﬂ Select Setup TCP/IP in the Protocols column and change the settings as ap-
propriate.

If unsure of the correct Subnet mask, and the first number in the IP address
of Network Interface Board is from 192 to 254, then use 255.255.255.0 as the
Subnet mask.

B Type the sysadm password in the appropriate box and click Accept Set-
tings.
After a few seconds, the screen should report that the update was successful.
Click the Back Arrow icon twice to return to the Network Configuration page.

B Optional: Click Configure Status Page in the Printer column to define pow-
er-up status page settings, for example, disabling the power-up status page.



UNIX Configuration

ﬂ The changes made to Network Interface Board do not take effect until the
unit is reset.

Click Reset in the System column and click Reset Unit.

After a few seconds, a message should appear on the screen saying that the
unit was reset.

TCP/IP configuration is now complete.
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Addendum for

Network Interface Board Quick Configuration Guide

Windows 2000 Configuration

This manual describes the procedures and provides necessary information
about setting up and using the printer under the network environment using
Windows 2000. It is useful to see “Network Interface Board Type 450-E Quick
Configuration Guide” for further information in addition to this manual.

See “Addendum for Printer Reference” to install the printer driver.



Configuration Programs

% PortNavi
IP Peer-to-Peer printing software
PortNavi is a utility that helps you to use network printers effectively. It is
useful in environments where two or more network printers are used. It is
recommended that you install PortNavi to use Parallel Printing and Recovery
Printing. For more information about PortNavi, see Help of PortNavi.

ﬂlmportant

O If you upgrade to Windows 2000 from Windows 95/98, PortNavi must be
uninstalled prior to installing Windows 2000. You must reinstall it after
upgrading to the Windows 2000 environment.

4 Note

O Parallel Printing and Recovery Printing are not available when you print
without using the PCL6/5e printer driver.

* PortNavi Features
Allow you to send a print job directly to the network printers without us-
ing a print server.

* Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬁlmportant
O The following settings must be the same for the specified printer and
the printers selected for Parallel Printing.

*  Printers are the exact same model.

* Installed options (e.g. Paper Tray)

*  Size and orientation of paper in each paper tray
*  Total memory

* Installed fonts (including the downloaded fonts)

e Allow you to print documents using other printers in the printer group
when the specified printer is busy (Recovery Printing).

i!klmportant
O The following settings must be the same for the specified printer and
the printers selected for Recovery Printing.

*  Printers are the exact same model.

* Installed options (e.g. Paper Tray)

*  Size and orientation of paper in each paper tray
*  Total memory

* Installed fonts (including the downloaded fonts)



< PRINTER MANAGER FOR ADMINISTRATOR
A utility for the system administrator to manage printers on the network.

p Reference

For the name of PRINTER MANAGER FOR ADMINISTRATOR, see the
inside of the front cover of “Quick Configuration Guide” for optional Net-
work Interface Board which is included as a PDF file on the CD-ROM la-
beled “Printer Drivers and Utilities”.

See PRINTER MANAGER FOR ADMINISTRATOR Online Help for more
information about using PRINTER MANAGER FOR ADMINISTRATOR.

< PRINTER MANAGER FOR CLIENT
A utility for users to manage their own print status on the network.

p Reference

For the name of PRINTER MANAGER FOR CLIENT, see the inside of the
front cover of “Quick Configuration Guide” for optional Network Inter-
face Board which is included as a PDF file on the CD-ROM labeled “Printer
Drivers and Utilities”.

See PRINTER MANAGER FOR CLIENT Online Help for more informa-
tion about using PRINTER MANAGER FOR CLIENT.

iﬁklmportant

O Configuration programs of IP Peer-to-Peer and IPX Peer-to-Peer which are in-
cluded on the CD-ROM labeled “Print Server Software and Documentation”
that comes with optional Network Interface Board, are not guaranteed to
work correctly in the Windows 2000 environment.



Installing NIB Setup Tool

A utility called NIB Setup Tool is provided to configure the printer to work in a
network environment. This section describes how to install PRINTER MANAG-
ER FOR ADMINISTRATOR, and how to run NIB Setup Tool.

Installing PRINTER MANAGER FOR ADMINISTRATOR
Follow these steps to install PRINTER MANAGER FOR ADMINISTRATOR.

E Preparation
You should install PRINTER MANAGER FOR ADMINISTRATOR on the
computer. If you install PRINTER MANAGER FOR ADMINISTRATOR from
a file server or run it via the network, PRINTER MANAGER FOR ADMINIS-
TRATOR might not work correctly.

Be sure to close all applications before starting the installation procedure.
ﬂ Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the setup menu starts automatically, follow the instructions on the screen.
If not, go to step E.

B Open [Control Pand), and double-click the [Add/Remove Program$icon.
B Click [Add New Programg, and then click [CD or Floppj.
B Click [Next >

Bln the [Open] box, type the name of the CD-ROM drive followed by
“\NETWORK\PRINTMAN\ADMIN\DISKI\SETUP.EXE” (do not in-
clude the quotation marks) and then click [Finish].

4 Note

O An example would be “D:ANETWORK\PRINTMAN\ADMIN\DISK1\
SETUP.EXE” when the CD-ROM drive name is “D”.

t From the [Choose Setup Languagk pop-up menu, select the language you
want to use.

B In the [Welcome] dialog box, click [Next >].

g The Software License Agreement appears.

After reading through all of the contents by clicking [PageDowr, click [Yes] to
agree with the License Agreement.



[E] Select a folder to install PRINTER MANAGER FOR ADMINISTRATOR
in, and then click [Next >].

If you want to change the displayed folder, click [Browse] to select another
one.

The installation program starts.

When a confirmation dialog box appears, the installation program is com-
plete.

Running NIB Setup Tool

ﬂ Click [Starf, point to [Programg, and then click [NIB Setup Too) in the [PRINT-
ER MANAGER FOR ADMINISTRATDfRrogram folder.

LFstatus page

The status page of Network Interface Board will be automatically printed in the
following cases:

* when the printer is turned on.

* when Network Interface Board is reset.

This feature can be disabled with NIB Setup Tool.

To disable this feature, check [Property Shee] in the “NIB Setup Tool” screen,
Click [Detailed..] in the [Generall tab and remove the check from the box for “Print
configuration page on start up.”



Using PortNavi

ﬂlmportant

O To use PortNavi, you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of PRINTER MANAGER FOR CLI-
ENT you use, see the inside of the front cover of “Quick Configuration
Guide” for optional Network Interface Board which is included as a PDF file
on the CD-ROM labeled “Printer Drivers and Utilities”.

Installing PortNavi

Follow these instructions to install PortNavi.

ﬂ Configure the IP parameters on Network Interface Board using the opera-
tion panel.

p Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

& Note
O If the installer starts automatically, use it to install PortNavi, and then go
to step @.

B Open [Control Pand), and double-click the [Add/Remove Program$icon.
B Click [Add New Programg, and then click [CD or Floppj.
B Click [Next >].

BType the name of the CD-ROM drive in the [Open] box, followed by
“\NETWORK\PORTNAVI\DISKI\SETUP.EXE” (do not include the
quotation marks), and then click [Finish].

4 Note

O An example would be “D:\NETWORK\PORTNAVI\DISKI\SETUP.EXE”
when the drive letter is “D”.

ﬂ After the [Welcome] dialog box appears, click [Next >].

B If PRINTER MANAGER FOR CLIENT is not installed, the [Question] dialog
box appears. When this occurs, click [No] and install PRINTER MANAGER
FOR CLIENT. If PRINTER MANAGER FOR CLIENT is installed, click
[Yes].



B click [yes].
The [Question] dialog box appears.

[E] If you want to read “Readme File”, click [Yes].

[i] After the [Setup Completd dialog box appears, click [Yes, | want to restart my
computer now], and click [Finish].

The computer restarts, and PortNavi can now be used. If you select “No”, be
sure to restart the computer manually before launching PortNavi for the first
time.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see Help of Port-
Navi.

ﬂ From the [Printerd window, click to select the icon of the printer which uses
PortNavi port to print, and then click [Propertieq in the [File] menu.

B Click to select the [Portg] tab, then confirm that the PortNavi port is shown
in the [Print to the following port($)box and that the check box is selected.

Remember the port name because this port should be deleted later.
B Click to select the [FILE] check box in the [Porf column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same printer.
B Click to select the [Portg] tab.

At the [Porfl column in the [Print to the following port($)dialog box, click to se-
lect the PortNavi port name as confirmed in step B.

B Click [Delete Pori.

g When the confirmation message appears, click [Yes].
The port is deleted.

[E] Click [OK] to close the Printer Properties.



Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi with Windows 2000.

ﬁlmportant
O If you want to switch the IP Peer-to-Peer port to the PortNavi port for print-
ing, delete the IP Peer-to-Peer port before adding the PortNavi port.

ﬂ Install the printer driver you want to use.

B From the [Printerd window, click to select the installed printer icon then
click [Propertieq in the [File] menu.

B Click to select the [Portg] tab and then click [Add Por{.

ﬂ Click to select [PortNav] in the [Port typeq box and then click [New Por{.

The [Select Printel dialog box appears and printers on the network can be
browsed.

The displayed items are as follows:

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.

B Click to select the model name of the printer then click [OK].

If you want to select a printer which is not shown here, click [IP Addresq to
type the IP address.

[ click [Closd in the [Printer Port§ dialog box.

ﬂ Confirm that the name of the PortNavi port is shown in the [Print to the fol-
lowing port(s] dialog box and its check box is selected then click [OK].

The name of the PortNavi port is shown as "IP address@model name".
The configuration is now complete.

When printing, select the configured printer and print as usual. Printing will
be done automatically by PortNavi.



Accessing the Port Settings Dialog Box

This section describes how to access the Port Settings dialog box to enable Par-
allel Printing and Recovery Printing.

p Reference

For more information about the procedures for Parallel Printing and Recov-
ery Printing, see Help of PortNavi.

ﬂ Click [Starf on the taskbar, point to [Settingd, and click [Printerd.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

Bl sclect the [Portg tab and click [Configure Porl.
The PortNavi settings dialog box appears.
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Standard TCP/IP Printing

Standard TCP/IP is a standard port of Windows 2000 to enable Peer-to-Peer
printing in a network environment.

For more information about Standard TCP/IP settings, see Help of Windows
2000.



NetWare Configuration

This section describes how to set up a Windows 2000 client.

For more information about server settings, see “Network Interface Board Type
450-E Quick Configuration Guide” which is included as a PDF file on the CD-
ROM labeled "Printer Drivers and Utilities".

Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

Follow these steps to set up a Windows 2000 client.

E Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [My Network Placeg icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The [Printerd dialog box appears.
B click [Nal.
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
"Installing the PCL 6/5e Printer Driver" and "Installing the PostScript Printer
Driver" in the "Addendum for Printer Reference" to start the installation and
then go to the next step.

B the [Printer Installatiohdialog box appears.
B From the [Por{ list, select the queue you selected in step @, and click [Next >].

ﬂ Follow the instructions on the screen to finish the installation of the printer
driver.

11
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Network Interface
Board Type 450-E
(option)

Quick Configuration Guide

@ Getting Ready for Software Installation

@ Windows 95/98/Me Configuration

@ Windows 2000/XP Configuration

@ Windows NT 4.0 Configuration

@ Dynamic Host Configuration Protocol (DHCP)
@ NetWare Configuration

Macintosh Configuration

For safety, please read this manual carefully before you use this product and keep it handy
for future reference.



Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

NetWare® is a registered trademark of Novell, Incorporated. Windows® is a registered trademark of Mi-
crosoft Corporation in the United States and/or other countries.

Macintosh® is a registered trademark of Apple Computer, Incorporated.

All other products referenced are trademarks or registered trademarks of their respective companies.
Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights in those marks.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

iﬁklmportant
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

5] Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

& Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

? Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

A Reference
This symbol indicates a reference.

[ ]

Keys that appear on the machine's display panel.

Keys and buttons that appear on the computer's display.
[ ]

Keys built into the machine's control panel.

Keys on the computer's keyboard.



Manuails for This Machine

Manuals for this Machine

There are seven manuals that separately describe the procedures for the instal-
lation of a machine and for the operation and maintenance of the machine and
its optional equipment.

To enhance safe and efficient operation of the machine, all users should read and
follow the instructions contained in the following manuals.
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Copy Reference
Describes the procedures and functions for using this machine as a copier.

System Settings
Describes the system settings of this machine.

Printer Reference 1
Describes the system settings, procedures and functions for using this ma-
chine as a printer.

Printer Reference 2
Describes the procedures and provides necessary information about using

this machine as a printer. The manual is included as a PDF file on the CD-
ROM labeled “Printer Drivers and Utilities”.

Network Interface Board Quick Configuration Guide

Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. We recommend
this manual as your first choice. The manual is included as a PDF file on the
CD-ROM labeled “Printer Drivers and Utilities”. (This Manual)

Read this manual as your first choice before referring to the paper version of
the Quick Configuration Guide which comes with optional Network Inter-
face Board Type 450-E.

PostScript 3 Operating Instructions Supplement

Describes the menus and features you can set using the PostScript 3 printer
driver. The manual is included as a PDF file on the CD-ROM labeled “Printer
Drivers and Utilities”.

Network Interface Board Type 450-E Owner's Manual

Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. The manual is pro-
vided as a PDF file which is included on the CD-ROM labeled “Print Server
Software and Documentation” which comes with optional Network Interface
Board Type 450-E.



L
1. Getting Ready for Software
Installation

Supported programs for the installation and configuration of the Network Inter-
face Board are provided on two CD-ROMs. One is “Printer Drivers and Utilities”
which comes with this machine, and the other is “Print Server Software and Doc-
umentation” which comes with the optional Network Interface Board type 450-
E.

You can select any of the programs listed in the Configuration Programs.

Configuration Programs

The CD-ROM labeled “Printer Drivers and Utilities” includes the following util-
ities.
+ SmartNetMonitor for Admin
SmartNetMonitor for Admin is software that uses the TCP/IP and IPX/SPX
protocols to monitor the printers in a network. It can monitor multiple net-

work printers having IP addresses. We recommend network administrators
to use this software.

/O Reference

For more information about SmartNetMonitor for Admin, see the Smart-
NetMonitor for Admin Help file.

<

«» SmartNetMonitor for Client
SmartNetMonitor for Client is software equipped with the following func-
tions. We recommend all users of this machine to install this software.

¢ Provides the function to print in a Peer-to-Peer network.
¢ Uses the TCP/IP and IPX/SPX protocols to monitor the status of devices
in a network constantly.

/O Reference

For more information about SmartNetMonitor for Client, see the Smart-
NetMonitor for Client Help file.

The CD-ROM labeled “Print Server Software and Documentation” includes the
following utilities.

< MAP
Web-based configuration utility

< IPX Peer-to-Peer
IPX Peer-to-Peer printing software

< IP Peer-to-Peer
IP Peer-to-Peer printing software

< NWSetup
NetWare Print Service Configuration 3



Getting Ready for Software Installation

The four utilities are provided on the “Print Server Software and Documenta-
tion” CD-ROM, but you need this CD-ROM only if you use “IPX Peer-to-Peer”
or “IP Peer-to-Peer” printing.

Although you can use the “MAP” or “NWSetup” utilities on the “Print Server
Software and Documentation” CD-ROM, it is easier to use the SmartNetMonitor
for Client/ Admin provided on the “Printer Drivers and Utilities” CD-ROM.

To use “MAP” or “NWSetup” from the “Print Server Software and Documenta-
tion” CD-ROM, see the “Owner's Manual”on the CD-ROM labeled “Print Server
Software and Documentation” for instructions.



2. Windows 95/98/Me
Configuration

Windows 95/98/Me Configuration

This section describes how to configure the Peer-to-Peer printing. The Peer-to-
Peer printing software that is provided on the CD-ROM labeled “Printer Drivers
and Utilities”. “Print Server Software and Documentation” allows Windows
95/98/Me PCs to communicate directly with network attached printers. A net-
work server, such as NetWare or Windows NT, is not required for Peer-to-Peer
printing.

There are three types of Peer-to-Peer printing. You can select “SmartNetMonitor
for Client/ Admin”, “IP Peer-to-Peer” and “IPX Peer-to-Peer” according to your
network environment.

The Peer-to-Peer printing software must be installed on each PC that uses Peer-
to-Peer printing. Once Peer-to-Peer printing software is installed, all Network
Interface Boards on the network automatically appear in the list of available
printer ports.

The Peer-to-Peer printing software can also be used in networks where servers
are present; however, server based print services are often utilized instead. Serv-
er based print services offer centralized printing management and spooling and
do not require software (other than the printer driver) to be installed on each PC.

If you use the machine in a network where servers are present, select either Peer-
to-Peer printing or the server based print service.

/O Reference

For more information about setting IP parameters, see “Configuring the
Printer for the Network with the Control Panel” in the “Printer Reference 1”
manual.
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Using SmartNetMonitor for Client

Installing the SmartNetMonitor for Client/Admin

For information about installing the SmartNetMonitor for Client, see “Installing
the SmartNetMonitor for Client/ Admin” in the “Printer Reference 1” manual.

Setting up the printer driver

ﬂ Install the printer driver you want to use.

g From the [Printers] window, click the icon of the machine whose printer
driver you want to use, and then click [Properties] in the [File] menu.

B Click the [Details] tab and click [Add Port].

ﬂ Click [Other], click to select [SmartNetMonitor] from the list and then click
[OK].

Available machines will be listed.

B Select a machine you want to use.

TCP/IP

@ Click the machine you want to use.

& Note

O Machines that respond to an IP broadcast from the computer will be dis-
played. To print to a machine not listed here, click [Specify Address], and
then type the IP address or host name.

O You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used.

A ciick [ox.

ﬂ Confirm that the selected port is highlighted, and then click [OK].
8 Restart the computer after the installation is complete.

g Set up the options with the printer driver.

p Reference

For more information about settings for options, see “Installing the Printer
Driver and Software” in the “Printer Reference 1” manual.



Using SmartNetMonitor for Client

Accessing the Port Settings Dialog Box

This section describes how to access the [Port Settings] dialog box to change the
settings of SmartNetMonitor for Client.

pe Reference
For more information about these settings, see SmartNetMonitor for Client
Help.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
g Click the icon of the machine you want to use.
B On the [File] menu, click [Properties].

ﬂ Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.
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Using IP Peer-to-Peer

ﬂlmportant

O The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that
the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

ﬂlmportant
O Confirm that the machine power is turned on before starting the following
procedure.

ﬂ Configure the IP parameters on the Network Interface Board using the con-
trol panel.

p Reference

For more information about setting IP parameters, see “Configuring the
Printer for the Network with the Control Panel” in the “Printer Reference
1” manual.

ﬂ Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

& Note
O If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
4.0].

B Click [CD ROM Contents].
The “Introduction” page appears.

ﬂ Click [Installation/Configuration Programs].
The “Configuration Programs” page appears.

B Click [Windows 95/98 & NT 4.x IP Peer-to-Peer Printing].
The “Windows 95/98 and NT 4.x IP Peer-to-Peer Printing” page appears.
This page describes the functions of this utility.

E At the bottom of the page, click the blue word [here] to begin installing.
A dialog box appears asking if the “Setup.exe” program should be started.

ﬂ The [Welcome] dialog box appears.
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B click [Nexi].
The [Installation Notes] dialog box appears.

B crick [ves].
The [Choose Destination Directory] dialog box appears.

[E Click [Browse] to set a different folder.
The default installation folder is C:\Program Files\IP-P2P.

B cick [Next].
The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

[ﬂ Type the name that you wish to see in “Program Folder:” and click [Next].
The files are then copied to the computer in the specified directories.

[B Follow the instructions on the screen.
m Click [OK] to complete the installation.

p Reference

For more information about installing IP Peer-to-Peer, see the “Owner's
Manual” on the CD-ROM labeled “Print Server Software and Documenta-
tion”.

LFor manual installation

Follow these steps to install the software on your operating system (Windows
95/98/Me).

@ Insert the CD-ROM into the CD-ROM drive.
@ Close all the applications that are currently running.
® Click [Start] on the task bar, and click [Run].

@ Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

® Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to - i in the preceding procedure. = p.8 “In-
stalling IP Peer-to-Peer”
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Selecting the Printer Port

The Peer-to-Peer printing software should be installed on each Windows
95/98/Me PC that will use Peer-to-Peer printing services.

ﬂ Install the printer driver you want to use.
If the printer drivers have already been installed, you can go to the next step.

pe Reference
For more information about the printer drivers, see “Installing the PCL

6/5e Printer Driver” or “Installing the PostScript 3 Printer Driver” in the
“Printer Reference 1” manual.
ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.
B Click the icon of the machine you want to set up for Peer-to-Peer printing.

ﬂ On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

B click the [Details] tab.

B From the [Print to the following port:] list box, select the port of the machine
you want to use for Peer-to-Peer printing.

¢ Select the IP address of the machine. If you do not find the IP address of
the machine, the machine is not in your local subnet. Then you need to con-
figure IP Peer-to-Peer port manually as described in the “Owner's Manu-
al” on the CD-ROM labeled “Print Server Software and Documentation”.

t click [0k,
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Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about IP Peer-to-Peer, see the
“Owner's Manual” on the CD-ROM labeled “Print Server Software and Docu-
mentation”.

ﬂ Click [Start] on the taskbar, point to [Programs], and then click [IP-P2P].
The [IP-PeerToPeer Setup] window appears.

g Click [Printers...].

B Click [Find Printers].
Available machines appear.

ﬂ Click to select the port you want to delete from “Unit Name” list.

B click [pelete].

11
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Using IPX Peer-to-Peer

ﬂlmportant

O The IPX protocol is required for IPX Peer-to-Peer printing. Confirm that the
IPX protocol is installed, if not, install it before starting the following proce-
dure.

& Note
O IPX protocol can be used with Windows 95/98.

Installing IPX Peer-to-Peer

Follow these steps to install IPX Peer-to-Peer.

ﬂ Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

@ Note

O If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
4.0].

g Click [CD ROM Contents].
The “Introduction” page appears.

B Click [Installation/Configuration Programs].
The “Configuration Programs” page appears.

ﬂ Click [Windows 95/98 IPX Peer-to-Peer Printing].
The “Windows 95/98 IPX Peer-to-Peer Printing” page appears.
This page describes the functions of this utility.

B At the bottom of the page, click the blue word [here] to begin installing.
A dialog box appears asking if the “Setup.exe” program should be started.

A click [ves.
The [Welcome] dialog box appears.

t cick [Next].
The [IPX Setup] dialog box appears.

B crick [ox.
The files are then copied to the computer in the specified directories.
The [Installation Complete] dialog box appears.

g Click [Finish] to complete the installation.
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LFor manual installation

Follow these steps to install the software on your operating system (Windows
95/98/Me).

@ Insert the CD-ROM into the CD-ROM drive.

® Close all the applications that are currently running.

® Click [Start] on the taskbar, and click [Run].

@ Type <Drive>:\IPX-P2P\SETUP.EXE (where <Drive> is your CD-ROM
drive name).

® Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to il - Bin the preceding procedure. = p.12 “In-
stalling IPX Peer-to-Peer”

Selecting the Printer Port

The Peer-to-Peer printing software should be installed on each Windows
95/98/Me PC that will use Peer-to-Peer printing services.
ﬂ Install the printer driver you want to use.
If the printer drivers have already been installed, you can go to the next step.
ﬂlmportant

O Using IPX Peer-to-Peer printing, confirm that the machine power is turned
on before continuing the following steps.

p Reference

For more information about the printer drivers, see “Installing the PCL
6/5e Printer Driver” or “Installing the PostScript 3 Printer Driver” in the
“Printer Reference 1” manual.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the machine you want to set up for the Peer-to-Peer print-
ing.

B On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

B click the [Details] tab.

13
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B From the [Print to the following port:] list box, select the port of the machine
you want to use for Peer-to-Peer printing.

* Select the machine name. The machine name is shown in “Peer-to-Peer
Connection Information” on the network configuration page. The default
setting of the printer name is “RDP_" followed by the 6 digit serial
number.

E W crick [0k,

14



Windows 2000/XP Configuration

This manual describes the procedures and provides necessary information
about setting up and using the machine under the network environment using
Windows 2000/ XP.

¢ If a NetWare server is present, NetWare print services might be used by fol-
lowing the NetWare Configuration instructions in this guide.

15
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Using SmartNetMonitor for Client

Installing SmartNetMonitor for Client

? Limitation

O If your system is Windows 2000/ XP, installing software by Auto Run re-
quires Administrators permission. When you install a printer driver by Auto
Run, log on using an account that has Administrators permission.

For information about installing the SmartNetMonitor for Client, see “Installing
the SmartNetMonitor for Client/ Admin” in the “Printer Reference 1” manual.

Setting up the printer driver

ﬂ Install the printer driver you want to use.

g From the [Printers] window, click the icon of the machine whose printer
driver you want to use, and then click [Properties] in the [File] menu.

& Note

O In Windows XP, from the [Printers and Faxes] window, click the icon of the
machine whose printer driver you want to use, and then click [Properties]
in the [File] menu.

B Click the [Details] tab and click [Add Port].

& Note
O In Windows XP, click the [Ports] tab and click [Add Port].

ﬂ Click [Other], click to select [SmartNetMonitor] from the list and then click
[OK].
Available machines will be listed.

@ Note

3 In Windows XP, click to select [SmartNetMonitor] from the list and then click
[New Port].



Using SmartNetMonitor for Client

B Select a machine you want to use.

TCP/IP

@ Click the machine you want to use.

& Note

O Machines that respond to an IP broadcast from the computer will be dis-
played. To print to a machine not listed here, click [Specify Address], and
then type the IP address or host name.

O You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used.

A ciick [ox.
ﬂ Confirm that the selected port is highlighted, and then click [Close].

Accessing the Port Configuration Dialog Box

This section describes how to access the [Port Configuration] dialog box to change
the settings of SmartNetMonitor for Client.

p Reference

For more information about these settings, see SmartNetMonitor for Client
Help.

ﬂ Click [Start] on the taskbar, point to [Settings], and click [Printers].

& Note

O In Windows XP Professional, access the [Printers and Faxes] window from
[Start] on the taskbar.

O In Windows XP Home Edition, access the [Printers and Faxes] window.
Click [Start] on the taskbar, click [Control Panel], [Printers and Other Hardware]
and then [Printers and Faxes].

g Click the icon of the machine you want to use.
B On the [File] menu, click [Properties].

ﬂ Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.

17
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Printing with a Standard TCP/IP Port

Installing the Printer Driver

ﬂ Install the printer driver you want to use.

ﬂ From the [Printers] window, click the icon of the machine whose printer
driver you want to use, and then click [Properties] in the [File] menu.

& Note

O In Windows XP, from the [Printers and Faxes] window, click the icon of the
machine whose printer driver you want to use, and then click [Properties]
in the [File] menu.

B Click the [Ports] tab and click [Add Port].

& Note
O In Windows XP, click the [Ports] tab and click [Add Port].

ﬂ Select [Standard TCP/IP Port], and then click [OK].
The [Add Standard TCP/IP Printer Port Wizard] window appears.

& Note
O In Windows XP, select [Standard TCP/IP Port], and then click [New Port].

B Click [Next] in the “Add Standard TCP/IP Printer Port Wizard” window.

B Type the IP address in the “Printer Name or IP Address” box, and then click
[Next].

ﬂ Click [Finish] in the “Add Standard TCP/IP Printer Port Wizard” window.

& Note

O During configuration of Standard TCP/IP port, the [Additional Port Informa-
tion Required] dialog box may appear. In this case, click [Standard] in the [De-
vice Type] box and then select [RICOH Network Printer D model] from the list.
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4. Windows NT 4.0 Configuration

Windows NT 4.0 Configuration

There are several options for setting up printing in a Windows NT environment.

* If a NetWare server is present, NetWare print services might be used by fol-
lowing the NetWare Configuration instructions in this guide.

* Peer-to-Peer print services can be available by using “IP Peer-to-Peer”.

e LPR print services can be used via TCP/IP by following the instructions in
this section.

Windows NT printing is very flexible. It is possible to configure the individual
Windows NT or Windows 95/98/Me workstations to print using a different
protocol from the Windows NT server. For example, a Windows NT server
could be configured to print to the Network Interface Board via TCP/IP using
the instructions in this section. The Network Interface Board could then be des-
ignated as shared on the NT server, allowing workstations to print via the NT
server using a different protocol.

The optimum Windows NT printing configuration depends on the particular
environment and user as well as administrator experience and preferences. Gen-
erally, LPR printing over TCP/IP covered in the following instructions is the
best choice for environments where TCP/IP is already in use.

19
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Using the SmartNetMonitor for Client

Installing the SmartNetMonitor for Client

? Limitation

O If your system is Windows NT 4.0, installing software by Auto Run requires
Administrators permission. When you install a printer driver by Auto Run,
log on using an account that has Administrators permission.

For information about installing the SmartNetMonitor for Client, see “Installing
the SmartNetMonitor for Client/ Admin” in the “Printer Reference 1” manual.

Setting up the printer driver

ﬂ Install the printer driver you want to use.

g From the [Printers] window, click the icon of the machine whose printer
driver you want to use, and then click [Properties] in the [File] menu.

B Click the [Ports] tab and click [Add Port].

ﬂ Click to select [SmartNetMonitor] from the list and then click [New Port].
Available machines will be listed.

B Select a machine you want to use.

TCP/IP

@ Click the machine you want to use.

& Note

O Machines that respond to an IP broadcast from the computer will be dis-
played. To print to a machine not listed here, click [Specify Address], and
then type the IP address or host name.

O You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-

not be used.
A ciick [ox.
ﬂ Confirm that the selected port is highlighted, and then click [OK].

B Restart the computer after the installation is complete.



Using the SmartNetMonitor for Client

g Set up the options with the printer driver.

/O Reference

For more information about settings for options, see“Installing the Printer
Driver and Software” in the “Printer Reference 1” manual.

Accessing the Port Configuration Dialog Box

This section describes how to access the [Port Configuration] dialog box to change
the settings of SmartNetMonitor for Client.

p Reference

For more information about these settings, see SmartNetMonitor for Client
Help.

ﬂ Click [Start] on the taskbar, point to [Settings], and click [Printers].
ﬂ Click the icon of the machine you want to use.
E) On the [File] menu, click [Properties].

ﬂ Click the [Ports] tab and click [Configure Port].
The [Port Configuration] dialog box appears.

2]
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Using IP Peer-to-Peer

ﬂlmportant

O The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that
the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

ﬂlmportant
O Confirm that the machine power is turned on before starting the following
procedure.

ﬂ Configure the IP parameters on the Network Interface Board using the con-
trol panel.

p Reference

For more information about setting IP parameters, see “Configuring the
Printer for the Network with the Control Panel” in the “Printer Reference
1” manual.

ﬂ Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

& Note
O If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
4.0].

B Click [CD ROM Contents].
The “Introduction” page appears.

ﬂ Click [Installation/Configuration Programs].
The “Configuration Programs” page appears.

B Click [Windows 95/98 & NT 4.x IP Peer-to-Peer Printing].
The “Windows 95/98 and NT 4.x IP Peer-to-Peer Printing” page appears.
This screen describes the functions of this utility.

E At the bottom of the page, click the blue word [here] to begin installing.
A dialog box appears asking if the “Setup.exe” program should be started.

ﬂ Click [Yes]. The [Welcome] dialog box appears.



Using IP Peer-to-Peer

B click [Nexi].
The [Installation Notes] dialog box appears.

B crick [ves].
The [Choose Destination Directory] dialog box appears.

[E Click [Browse] to set a different folder.
The default installation folder is C:\Program Files\IP-P2P.

B cick [Next].
The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

[ﬂ Type the name that you want to see in the Program Folder and click [Next].
The files are then copied to the computer in the specified directories.

[B Follow the instructions on the screen.
m Click [OK] to complete the installation.

p Reference

For more information about installing IP Peer-to-Peer, see the “Owner's
Manual” on the CD-ROM labeled “Print Server Software and Documenta-
tion”.

LFor manual installation

Follow these steps to install the software on your operating system (Windows
NT 4.0).

@ Insert the CD-ROM into the CD-ROM drive.
@ Close all the applications that are currently running.
® Click [Start] on the taskbar, and click [Run].

@ Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

® Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to B- B in the preceding procedure. = p.22 “In-
stalling IP Peer-to-Peer”

23
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Selecting the Printer Port

The IP Peer-to-Peer printing software should be installed on each Windows NT
4.0 PC that uses Peer-to-Peer printing services.

ﬂlmportant
O The IP Peer-to-Peer printing software must be installed before selecting the
printer port.

ﬂ Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
“Installing the PCL 6/5e Printer Driver” in the “Printer Reference 1” manual
to start the installation and then go to the next step.

B In the [Install Printer Driver]dialog box,select the Port from the Printer Name.

ﬂ From the [Change settings for 'Port'] list, select the IP address of the machine
you want to set up, and click [Next].

B Follow the instructions on the screen to finish the installation of the printer
driver.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about IP Peer-to-Peer, see the
“Owner's Manual” on the CD-ROM labeled “Print Server Software and Docu-
mentation”.

B Click [Start] on the taskbar, point to [Programs], and then click [Ip-p2p].
The [IP-PeerToPeer Setup] window appears.

g Click [Printers...].

B Ciick [Find Printers].
Available machines appear.

ﬂ Click to select the port you want to delete from “Unit Name” list.
B Click [Delete].



Setting Up LPR Printing

Setting Up LPR Printing

Follow these steps to set up LPR printing.

& Note

O In the following instructions, some fields or dialog box names may vary de-
pending on the NT service pack in use.

ﬂ Configure the IP parameters on the Network Interface Board using the
control panel.

p Reference

For more information about setting IP parameters, see “Configuring the
Printer for the Network with the Control Panel” in the “Printer Reference
1” manual.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Control Panel].

BDouble-click [Network] and select the [Protocols] tab to confirm that the
TCP/IP protocol is installed.

If the TCP/IP protocol is not on the list of Network Protocols, click [Add] to
install it.

ﬂ Select the [Services] tab.
If Microsoft TCP /IP Printing is not on the list of Network Services, click [Add]
to install it.

B Click [OK] when all protocols and services have been added.

If the TCP/IP protocol has just been added, set the IP address and other
TCP/IP parameters.

The new protocols and services will be available after the computer is restart-
ed.

ﬂlmportant
O If the printer driver has not been installed yet, install it before continuing.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers].

ﬂ From the [Printers] window, click the icon of the machine whose printer
driver you want to use, and then click [Properties] in the [File] menu.

8 Click the [Ports] tab, and click [Add Port].
g Double-click [LPR Port] in the list of Available Printer Ports.

[E In the [Name or address of server providing Ipd:] field, type the IP address of the
Network Interface Board (that was assigned with the control panel).

25
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[I] In the [Name of printer or print queue on that server:] field, type “PORT1” (quo-
tation marks are not included) in capital letters and click [OK].

m Click [Close] to close the [Printer Ports] dialog box.

The IP address of the Network Interface Board is now displayed and current-
ly selected on the list of ports.

[B If the printer is to be shared, click the [Sharing] tab, select [Shared] and type
the [Share name].

@ click [oK].
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5. Dynamic Host Configuration

Protocol (DHCP)

Dynamic Host Configuration Protocol
(DHCP)

The Dynamic Host Configuration Protocol (DHCP) provides a mechanism for
delivering IP configuration parameters, including the IP address, subnet mask
and default gateway, to devices (hosts) on an IP network. A DHCP server man-
ages the pool of available IP addresses and grants device requests for an IP ad-
dress.

When the DHCP is set to on, the Network Interface Board broadcasts a DHCP
request for an IP address. If a DHCP server is present, the request might be proc-
essed, and the IP address might be returned to the Network Interface Board.
Upon receipt of the IP address, the Network Interface Board resets, and prints a
network configuration page. The network configuration page might list the new
IP address (and Subnet mask and default gateway). Once an IP address has been
assigned to the Network Interface Board, it might no longer broadcast DHCP re-
quests.

ﬂlmportant
O The IP address of the Network Interface Board assignment by DHCP works
only if the Network Interface Board does not have an existing IP address.

The DHCP server leases a temporary IP address which expires after a period of
time, or leases a permanent or unlimited lease which does not expire.

Devices that are granted a temporary lease are notified before the lease expires
and asked if they want to extend the lease. The Network Interface Board contin-
ues extending its lease indefinitely (unless prohibited by your DHCP server con-
figuration) and thus maintains a consistent IP address.

ﬂlmportant

O If the Network Interface Board is not turned on or is not connected to the net-
work during the period when the DHCP server is sending requests to extend
the lease, the lease will not be extended. The DHCP server might cancel the
lease and might assign the IP address to another device. Therefore, it is highly
recommended that you reserve an IP address for the Network Interface Board
in your DHCP server configuration.

If you change DHCP setting for IP address assignment, it can be enabled using
the NIB Setup Tool. The NIB Setup Tool allows you to use a Wizard or a Prop-
erty Sheet to configure the Network Interface Board. Use the Property Sheet to
enable or disable this feature. After you select the Network Interface Board with
the NIB Setup Tool, click [Configure] and then click the [TCP/IP] tab. If you do not
use DHCP, select [Specify an IP Address] and set the IP address, the subnet mask
and the default gateway address. If you use DHCP, select Obtain an IP Address
from DHCP server.
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@ Note

O If the IP address is not assigned to the Network Interface Board, you need to
install IPX protocol into your system and set IPX protocol in the NIB Setup
Tool.

O You can run the NIB Setup Tool on the [Tools] menu in the SmartNetMonitor
for Admin. For more information about installing the SmartNetMonitor for
Admin, see the “Printer Reference 1” manual.
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6. NetWare Configuration

This chapter describes how to configure the machine to use as a print server in a
NetWare environment.

+ SmartNetMonitor for Admin
To use a machine in a NetWare environment, configure the NetWare printing
environment by using SmartNetMonitor for Admin.

@ Note

O If you configure NetWare printing environment by using SmartNetMoni-
tor for Admin under following environment, NetWare Client which is pro-
vided by Novell is required.

e NDS mode in Windows 95/98/Me
* NDS or Bindary mode in Windows 2000/ XP/Windows NT4.0

< Printers listed by SmartNetMonitor for Admin
SmartNetMonitor for Admin displays a list of printers, which are connected
to the network.
If you cannot find out the machine from the displayed list, refer to the config-
uration page printed from the machine. For more information about printing
a configuration page, see “Printer Condition” in the “Printer Reference 2”
manual.

NetWare 3.x - Advanced Settings

This section describes how to configure your machine to use as a print server in
the NetWare 3.x environment.

Basic Procedure

( Installing the NIB Setup Toolj

( Configuring Network Interface Board )

(Configuring NetWare ]

||
( Turning the power off and on )

NW312-G-011

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.
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Setting Up as a Print Server

Follow these steps to set up the machine as a print server.

5] Preparation

Confirm that the SmartNetMonitor for Admin is installed. If it is not installed,
see “Installing the Printer Driver and Software” in the “Printer Reference 1”
manual to install it.

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
ﬂ Run SmartNetMonitor for Admin.

B Click the [Group] menu and click [Open LAN] and select [IPX/SPX].
A list of printers appears.

& Note

O If you cannot identify which machine to configure from the list of printers,
print Configuration Page from the machine and find the desired machine.
For more information about printing Configuration Page, see “Printer
Condition” in the “Printer Reference 2” manual.

ﬂ Click the machine you want to configure, and then click [NIB Setup Tool] on
the [Tools] menu.

B click [Wizard], and then click [OK].

B Type the device name into the [Device Name] box and comment into the [Com-
ment] box as necessary, and then click [Next].

ﬂ Select the [NetWare] check box, and then click [Next].

8 Click [Bindery], type the file server name into the [File Server Name:] box, and
then click [Next].

In the [File Server Name:] box, type the name of the file server in which a print
server is to be created. You can also select a file server from the list that ap-
pears by clicking [Browse].

g Type the print server name into the [Print Server Name] box, machine name
into the [Printer Name] box, and print queue name into the [Print Queue Name]
box, and then click [Next].

* In the [Print Server Name] box, type the name of the NetWare print server
within 47 characters.

¢ In the [Printer Name] box, type the name of the NetWare machine.

* In the [Print Queue Name] box, type the name of the print queue to be added
to NetWare.

[m After confirming the settings, click [Next].
The settings take effect, and the NIB setup tool exits.



NetWare 3.x - Advanced Settings

m Exit SmartNetMonitor for Admin.
m Turn the machine power off and on.

@ Note

O To confirm that the machine is configured correctly, type as follows from
the command prompt.

F:> USERLIST

If the machine works as configured, the name of the print server appears as
an attached user.P
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NetWare 4.x, 5.x - Advanced Settings

This section describes how to configure your machine to use as a print server in
the NetWare 4.x, 5.x environment.
< To use NetWare 5.x

* If you use Pure IP, use the machine as a print server. You cannot use the
machine as a remote printer when you use Pure IP.

Basic Procedure

( Installing the NIB Setup Tool)

( Configuring Network Interface Board )

(Configuring NetWare )

( Turning the power off and on )

NW312-G-011

Setting Up as a Print Server

Follow these steps to set up the machine as a print server.

5] Preparation

Confirm that the SmartNetMonitor for Admin is installed. If it is not installed,
see “Installing the Printer Driver and Software” in the “Printer Reference 1”
manual to install it.

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.

g Run SmartNetMonitor for Admin.

B Click the [Group] menu and click [Search Device] and select [IPX/SPX] or
[TCP/IP].
A list of printers appears.
& Note

O If you use Pure IP, select [TCP/IP].

O If you cannot identify which machine to configure from the list of printers,
print Configuration Page from the machine and find the desired machine.
For more information about printing Configuration Page, see “Printer
Condition” in the “Printer Reference 2” manual.
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ﬂ Click the machine you want to configure, and then click [NIB Setup Tool] on
the [Tools] menu.

@ Note

O If you use Pure IP, see p.34 “Using Pure IP in the NetWare 5.x environ-
ment”.

B click [Wizard], and then click [OK].

E Type the device name into the [Device Name] box and comment into the [Com-
ment] box as necessary, and then click [Next].

ﬂ Select the [NetWare] check box, and then click [Next].

B Click [NDS], type the file server name into the [File Server Name:] box, the
NDS tree name into the [Tree:] box and the context into the [Context:] box,
and then click [Next].

In the [File Server Name:] box, type the name of the file server in which a print
server is to be created. You can also select a file server from the list that ap-
pears by clicking [Browse].

Clicking [Browse], you can select a NDS context among those listed in the
[Browse] dialog box.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type "NET.DS".

g Type the print server name into the [Print Server Name] box, machine name
into the [Printer Name] box, print queue name into the [Print Queue Name] box,
and print queue volume into the [Print Queue Volume] box, and then click
[Next].

¢ In the [Print Server Name] box, type the name of the NetWare print server
within 47 characters.

¢ In the [Printer Name] box, type the name of the NetWare machine.

* In the [Print Queue Name] box, type the name of the print queue to be added
to NetWare.

* In the [Print Queue Volume], type the volume of print queue. As a volume,
object names are typed from a lower object and divided by a period. You
can select a volume by clicking [Browse].

[E After confirming the settings, click [Next].
The settings take effect, and the NIB setup tool exits.

m Exit SmartNetMonitor for Admin.

m Turn the machine power off and on.
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& Note
O To confirm that the machine is configured correctly, type as follows from
the command prompt.

F:> NLIST USER /A/B

If the machine works as configured, the name of the print server appears as
an attached user.

Using Pure IP in the NetWare 5.x environment

ﬂ Log on to the file server as an Admin or an Admin equivalent.
g Run SmartNetMonitor for Admin.

B Click [Property Sheet] and click [OK].
The [NIB Setup Tool] dialog box appears.

ﬂ Click the [NetWare] tab, and make the following settings.
@ In the [Print Server Name:] box, type the name of the print server.

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

© In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse Context] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".

O In the [Print Server Operation Mode] group, click [As Print Server].
@ Click [OK] to close the property sheet.

A confirmation dialog box appears.

O Click [OK].

B Exit SmartNetMonitor for Admin.
After this step, go to step B on p.32 “Setting Up as a Print Server”.



Setting Up a Client Computer

Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

After installing the printer driver, change the print port to NetWare queue.

& Note

O This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setup procedure.

Windows 95/98/Me

Follow these steps to set up a Windows 95/98/Me client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Install the printer driver you want to use.

/O Reference

For more information about installing the printer driver, see the “Printer
Reference 1” manual.

& Note

O Any portis selected during the installation, however, LPT1 is recommend-
ed.

ﬂ Click [Start], point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the machine you want to use.
B On the [File] menu, click [Properties].

B Click the [Details] tab, and click [Add Port].

[ ik [Network] and click [Browse].

ﬂ On the network tree, double-click the name of the file server.

The queues are displayed.
8 Click the queue you want to print, and click [OK].

B click [ok1.
In the [Print to the following port] box, a network path to the machine appears.

[E Click [OK] to close the [Printer Properties] dialog box, and again, open it.
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[ Click the [Printer Settings] tab.
m Clear the [Form feed] and the [Enable banner] check boxes.

& Note

O You should not select these check boxes because they should be specified
using the printer driver. If they are selected, the machine might not print
correctly.

When Using the PostScript 3 Printer Driver

Follow these steps to set up for the PostScript 3 Printer Driver.
@ Click the [PostScript] tab.
@ Click [Advanced].

@ Click to clear the [Send CTRL+D before job] and the [Send CTRL+D after job]
check boxes.

[B Click [OK] to close the [Printer Properties] dialog box.

Windows 2000/XP

Follow these steps to set up a Windows 2000/ XP client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [My Network Place] icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The [Printers] dialog box appears.
B click (No).
B Close all applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the “Printer reference 1” manual.

B Install the printer driver you want to use.
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B Click [Start], point to [Settings], and then click [Printers].
The [Printers] window appears.

@ Note

O In Windows XP Professional, access the [Printers and Faxes] window from
[Start] on the task bar.

O In Windows XP Home Edition, access the [Printers and Faxes] window.
Click [Start] on the task bar, click [Control Panel], [Printers and Other Hardware]
and then [Printers and Faxes]. The [Printers and Faxes] window appears.

ﬂ Click the icon of the machine you want to use.
B On the [File] menu, click [Properties].

g Select the queue you selected in step fJ from the [Port] list in the [Ports] tab,
and then click [OK].

Windows NT 4.0

Follow these steps to set up a Windows NT 4.0 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.
B click Noj.
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
the “Printer Reference 1” manual.

B Install the printer driver you want to use.

B Click [Start], point to [Settings], and then click [Printers].

ﬂ In the [Printers] window, click the icon of the machine you want to use.
B on the [File] menu, click [Properties].

g From the [Port] tab, select the queue you selected in step fJ, and then click
[Next].

[E Follow the instructions on the screen.
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Configuring Macintosh

This section describes how to configure a Macintosh to use EtherTalk. The actual
procedures to configure a Macintosh may vary depending on the version of the
Mac OS. The following procedure describes how to configure Mac OS 8. If you
are not using Mac OS 8, see the manual that comes with your version of the Mac
OS for more information.

Basic Procedure

Change to EtherTalk J

(
( Configure the printer )
[ Change the printer name]

Change the zone

MAC-G-010

? Limitation

O For use with Macintosh OS 8 or 9. With Mac OS X, the machine operates in
only Classic mode.

Changing to EtherTalk

Follow the procedure to configure a Macintosh to use EtherTalk.

/O Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

ﬂ Open [Control Panel], and then double-click the [AppleTalk] icon.

ﬂ From the [Connect via:] pop-up menu, select “Ethernet”.

B If you change zones, select a name from the [Current zone:] pop-up menu.
ﬂ Close the [AppleTalk] control panels.

B Restart the computer.
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Configuring the Printer

Use the control panel to activate the AppleTalk protocol. (The factory default is
active.)

Changing the Printer Name

If the network has several same model machines, the names will be the same.
Machines that have the same name will have their names changed slightly in the
Chooser. For example, three machines named “printer” will appear in the choos-
er as “printer0”, “printerl” and “printer2”.

For more information about changing the printer name, see the “PostScript 3
Operating Instructions Supplement” manual.

Changing the Zone

It may be necessary to change the zone configuration.

Use applications such as Apple Printer Utility or LaserWriter Utility to change
the zone configuration in the Macintosh EtherTalk environment. These utilities
are distributed by Apple Computer, Inc.

Follow these steps to use the Apple Printer Utility.
@ Insert the CD-ROM into the CD-ROM drive.
@ Copy the “Zone Name.ps” file in the “Zone Name” folder to the hard disk.

® Open the copied “Zone Name.ps” file using a text editor, and change “New-
Zone”, which is in the second line from the bottom, to the name of the new
zone.
%!PS-Adobe2.0
%%Title: Changing Zone (EtherNet only)
%% CreationDate: Tue Dec 16 1997
%%EndComments
true O startjob not {ERROR]} if
(%EtherTalk%) << /EtherTalkZone (NewZone) >> setdevparams
%%EQOF

@ Save “Zone Name.ps”.

® Run the Apple Printer Utility, and select the machine for which the new zone
name is to be used.

® Select [Send PostScript File] in the [Utilities] menu, and send “Zone Name.ps” to
the machine.
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